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QCAGUI-package About the QCAGUI Package

Description

QCAGUTI is a graphical user interface (GUI) for the QCA package, derived from R Commander.
Because QCA has little to do with statistics, the menus from Remdr were stripped down to the very
basics. In crisp sets QCA, data is binary therefore it is fairly decent to treat it as categorical (1 -
presence; 0 - absence). In order to ease the primary analysis (e.g. tables of frequencies) and the
creation of basic graphs, this package activates some menus that are not available in Remdr but for
factors. Users should be aware, however, that QCAGUI is not a package for statistics; Remdr is
better for this purpose
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Details
Package: QCAGUI
Type: Package
Version:  1.3-7
Date: 2009-10-10
License: GPL (>=2)
Author(s)

The package is 99% based on the Rcmdr package written by John Fox <jfox @mcmaster.ca>. Only
some additional menus were adapted for the QCA package by Adrian Dusa <adi@sas.unibuc.ro>

Rcmdr-package R Commander

Description

A platform-independent basic-statistics GUI (graphical user interface) for R, based on the tcltk
package.

Details

Package: Remdr

Version: 1.3-5

Date: 2007.07.30

Depends: R (>=2.1.0), tcltk, grDevices, utils

Suggests: abind, car (>= 1.1-1), effects (>= 1.0-7), foreign, grid, lattice, Imtest, MASS, mgcv, multcomp, nlme, nnet, relimj
LazyLoad: no

License: GPL (>=2)

URL: http://www.r-project.org, http://socserv.socsci.mcmaster.ca/jfox/Misc/Rcmdr/
Index:
Commander R Commander
Compute Rcmdr Compute Dialog
Confint Confidence Intervals for Model Coefficients
Hist Plot a Histogram
KMeans K-Means Clustering Using Multiple Random Seeds
Rcmdr.Utilities Rcmdr Utility Functions

Rcmdr.sciviews—specific

Rcmdr SciViews-specific Functions
RcmdrPager Pager for Text Files
Recode Rcmdr Recode Dialog



Scatter3DDialog
aboutRcmdr
assignCluster

bin.var
colPercents
generalizedLinearModel

hierarchicalCluster
linearModel
partial.cor
plotMeans
reliability
scatter3d

stem.leaf

Translations

assignCluster

Rcmdr 3D Scatterplot Dialog

About the Rcmdr Package

Append a Cluster Membership Variable to a
Dataframe

Bin a Numeric Varisible

Row, Column, and Total Percentage Tables

Rcmdr Generalized Linear Model Dialog
Rcmdr Hierarchical Clustering Dialog
Rcmdr Linear Model Dialog

Partial Correlations

Plot Means for One or Two-Way Layout
Reliability of a Composite Scale
Three-Dimensional Scatterplots and Point
Identification

Stem—-and-Leaf Display

The R Commander comes with translations from English into several other languages. I am grate-
ful to the following individuals for preparing these translations: Brazilian Portuguese, Adriano
Azevedo Filho; Catalan, Manel Salamero; French, Philippe Grosjean; German: Gerhard Schoen;
Indonesian, I Made Tirta; Italian, Stefano Calza; Japanese, Takaharu Araki; Romanian, Adrian
Dusa; Russian, Alexey Shipunov; Slovenian, Jaro Lajovic; Spanish, Carlos Enrique Carleos Ar-

time.

Author(s)

John Fox <jfox@mcmaster.ca>, with contributions from Michael Ash, Theophilius Boye, Ste-
fano Calza, Andy Chang, Philippe Grosjean, Richard Heiberger, G. Jay Kerns, Renaud Lancelot,
Matthieu Lesnoff, Martin Maechler, Dan Putler, Miroslav Ristic, and Peter Wolf.

Maintainer: John Fox <jfox @mcmaster.ca>

assignCluster

Append a Cluster Membership Variable to a Dataframe

Description

Correctly creates a cluster membership variable that can be attached to a dataframe when only a
subset of the observations in that dataframe were used to create the clustering solution. NAs are
assigned to the observations of the original dataframe not used in creating the clustering solution.

Usage

assignCluster (clusterData,

origData, clusterVec)
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Arguments

clusterData The data matrix used in the clustering solution. The data matrix may have have
only a subset of the observations contained in the original dataframe.

origData The original dataframe from which the data used in the clustering solution were
taken.

clusterVec An integer variable containing the cluster membership assignments for the ob-
servations used in creating the clustering solution. This vector can be created
using cutree for clustering solutions generated by hclust or the cluster
component of a list object created by kmeans or KMeans.

Value
A factor (with integer labels) that indicate the cluster assignment for each observation, with an NA
value given to observations not used in the clustering solution.

Author(s)

Dan Putler

See Also

hclust, cutree, kmeans, KMeans

Examples

data (USArrests)
USArrkm3 <- KMeans (USArrests[USArrests$UrbanPop<66, ], centers=3)
assignCluster (USArrests [USArrests$UrbanPop<66, ], USArrests, USArrkm3$cluster)

bigl0 Random data with 10 conditions and 1 outcome

Description

The data was randomly generated using set.seed(10)

Usage

data (bigl0)
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bin.var Bin a Numeric Varisible

Description

Create a factor dissecting the range of a numeric variable into bins of equal width, (roughly) equal
frequency, or at "natural" cut points. The cut function is used to create the factor.

Usage
bin.var(x, bins = 4, method = c("intervals", "proportions", "natural"),
labels = FALSE)
Arguments
X numeric variable to be binned.
bins number of bins.
method one of "intervals" for equal-width bins; "proportions" for equal-
count bins; "natural™" for cut points between bins to be determined by a
k-means clustering.
labels if FALSE, numeric labels will be used for the factor levels; if NULL, the cut
points are used to define labels; otherwise a character vector of level names.
Value
A factor.
Author(s)
Dan Putler, slightly modified by John Fox (jfox@mcmaster.ca) with the original author’s permis-
sion.
See Also

cut, kmeans.

Examples

summary (bin.var (rnorm(100), method="prop", labels=letters[1:4]))
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colPercents Row, Column, and Total Percentage Tables

Description

Percentage a matrix or higher-dimensional array of frequency counts by rows, columns, or total
frequency.

Usage

colPercents (tab, digits=1l)
rowPercents (tab, digits=1)
totPercents (tab, digits=1)

Arguments
tab a matrix or higher-dimensional array of frequency counts.
digits number of places to the right of the decimal place for percentages.
Value

Returns an array of the same size and shape as tab percentaged by rows or columns, plus rows or
columns of totals and counts, or by the table total.

Author(s)

John Fox (jfox @mcmaster.ca)

Commander R Commander

Description

Start the R Commander GUI (graphical user interface)

Usage

Commander ()
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Details
Getting Started

The default R Commander interface consists of (from top to bottom) a menu bar, a toolbar, a script
window, an output window, and a messages window.

Commands to read, write, transform, and analyze data are entered using the menus in the menu bar
at the top of the Commander window. Most menu items lead to dialog boxes requesting further
specification. I suggest that you explore the menus to see what is available.

Below the menu bar is a toolbar with (from left to right) an information field displaying the name
of the active data set; buttons for editing and displaying the active data set; and an information field
showing the active statistical model. There is also a Submit button for re-executing commands in the
script window. The information fields for the active data set and active model are actually buttons
that can be used to select the active data set and model from among, respectively, data frames or
suitable model objects in memory.

Almost all commands require an active data set. When the Commander starts, there is no active
data set, as indicated in the data set information field. A data set becomes the active data set when
it is read into memory from an R package or imported from a text file, SPSS data set, Minitab data
set, STATA data set, or an Excel, Access, or dBase data set. In addition, the active data set can be
selected from among R data frames resident in memory. You can therefore switch among data sets
during a session.

By default, commands are logged to the script window (the initially empty text window immediately
below the toolbar); commands and output appear in the output window (the initially empty text
window below the script window); and the active data set is attached to the search path. To alter
these and other defaults, see the information below on configuration.

Some Rcmdr dialogs (those in the Statistics -> Fit models menu) produce linear, generalized linear,
or other models. When a model is fit, it becomes the active model, as indicated in the information
field in the R Commander toolbar. Items in the Models menu apply to the active model. Initially,
there is no active model. If there are several models in memory, you can select the active model
from among them.

If command logging in turned on, R commands that are generated from the menus and dialog
boxes are entered into the script window in the Commander. You can edit these commands in the
normal manner and can also type new commands into the script window. Individual commands can
be continued over more than one line, the several lines of a multi-line command must be submitted
simultaneously. (It is not necessary, as in earlier versions of the R Commander, to begin continuation
lines with white space.) The contents of the script window can be saved during or at the end of the
session, and a saved script can be loaded into the script window. The contents of the output window
can also be edited or saved to a text file.

To re-execute a command or set of commands, select the lines to be executed using the mouse and
press the Submit button at the right of the toolbar (or Control-R, for "run"). If no text is selected,
the Submit button (or Control-R) submits the line containing the text-insertion cursor. Note that an
error will be generated if the submitted command or commands are incomplete.

Pressing Control-F brings up a find-text dialog box (which can also be accessed via Edit -> Find)
to search for text in the script window or the output window. Edit functions such as search are
performed in the script window unless you first click in the output window to make it the active
window.

Pressing Control-S will save the script or output window.
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Pressing Control-A selects all of the text in the script or output window.

Right-clicking the mouse (clicking button 3 on a three-button mouse) in the script or output window
brings up a "context" menu with the Edit-menu items, plus (in the script window) a Submit item.

When you execute commands from the Commander window, you must ensure that the sequence of
commands is logical. For example, it makes no sense to fit a statistical model to a data set that has
not been read into memory.

Pressing a letter key (e.g., "a") in a list box will scroll the list box to bring the next entry starting
with that letter to the top of the box.

Exit from the Commander via the File -> Exit menu or by closing the Commander window.
Customization and Configuration

Configuration files reside in the et c subdirectory of the package, or in the locations given by the
etc and et cMenus options (see below).

The Rcmdr menus can be customized by editing the file Remdr-menus . txt.

Some functions (e.g., hist) that do not normally create visible printed output when executed
from the R Console command prompt will do so — unless prevented — when executed from the
Commander script window. Such output can be suppressed by listing the names of these functions
in the log-exceptions.txt file.

You can add R code to the package, e.g., for creating additional dialogs, by placing files with file
type . R in the et c directory, also editing Recmdr—-menus . txt to provide additional menus, sub-
menus, or menu-items. A demo addition is provided in the file BoxCox .demo. To activate the
demo, rename this file to BoxCox.R, and uncomment the corresponding menu line in Rcmdr—
menus . txt. Alternatively, you can edit the source package and recompile it.

A number of functions are provided to assist in writing dialogs, and Rcmdr state information is
stored in a separate environment. See help ("Rcmdr.Utilities™") and the manual supplied
in the doc directory of the Recmdr package for more information.

In addition, several features are controlled by run-time options, set via the opt ions ("Rcmdr")
command. These options should be set before the package is loaded. If the options are unset, which
is the usual situation, defaults are used. Specify options as a list of name=value pairs. You can set
none, one, several, or all options. The available options are as follows:

attach.data.set if TRUE (the default is FALSE), the active data set is attached to the search
path.

check.packages if TRUE (the default), on start-up, the presence of all of the Remdr recom-
mended packages will be checked, and if any are absent, the Rcmdr will offer to install them.

command. text .color Color for commands in the output window; the defaultis "red".

console.output If TRUE, output is directed to the R Console, and the R Commander output
window is not displayed. The default is FALSE.

contrasts Serves the same function as the general contrasts option; the default is
c("contr.Treatment", "contr.poly"). Whenthe Commander exits, the contrasts
option is returned to its pre-existing value. Note that contr.Treatment is from the car
package.

crisp.dialogs If TRUE, dialogs should appear on the screen fully drawn, rather than built up
widget by widget. This option should affect the Windows version of R only, but should in any
event be harmless. The default is TRUE under Windows for R versions 2.1.1 and above, and
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FALSE otherwise. If you’re working on Windows and encounter increased stability problems,
trying setting this option to FALSE.

default. font The default font, as an X11 font specification, given in a character string. If
specified, this value takes precedence over the default font size (below). This option is only
for non-Windows systems.

default. font.size The size, in points, of the default font. The default is 10 for Windows
systems and 12 for other systems Unless otherwise specified (see the previous item), the de-
fault font is "xhelvetica-medium—-r—-normal—-x—-xx=*", where xx is the default font
size. This option is only for non-Windows systems.

double.click Set to TRUE if you want a double-click of the left mouse button to press the
default button in all dialogs. The default is FALSE.

error.text.color Color for error messages; the default is "red".

etc Set to the path of the directory containing the Remdr configuration files; defaults to the et c
subdirectory of the installed Rcmdr package.

grab. focus Setto TRUE for the current Tk window to "grab" the focus — that is, to prevent the
focus from being changed to another Tk window. On some systems, grabbing the focus in this
manner apparently causes problems. The default is TRUE. If you experience focus problems,
try setting this option to FALSE.

load.at.startup A character vector of names of packages to be loaded when the Rcmdr
package is loaded; the default is to load only the car package. Other required packages will
be loaded as needed. If it is available, the car package will be loaded at when the Commander
starts in any event.

log.commands If TRUE (the default), commands are echoed to the script window; if FALSE,
the script window is not displayed.

log. font .size The font size, in points, to be used in the script window, in the output window,
in recode dialogs, and in compute expressions — that is, where a monospaced font is used.
The default is 10 for Windows systems and 12 for other systems.

log.height The height of the script window, in lines. The default is 10. Setting 1og.height
to 0 has the same effect as setting 1og . commands to FALSE.

log.text.color Color for text in the script window; the defaultis "black".
log.width The width of the script and output windows, in characters. The default is 80.

multiple.select.mode Affectsthe way multiple variables are selected in variable-list boxes.
If set to "extended" (the default), left-clicking on a variable selects it and deselects any
other variables that are selected; Control-left-click toggles the selection (and may be used to
select additional variables); Shift-left-click extends the selection. This is the standard Win-
dows convention. If setto "multiple™, left-clicking toggles the selection of a variable and
may be used to select more than one variable. This is the behaviour in the Remdr prior to
version 1.9-10.

output .height The height of the output window, in lines. The default is twice the height of
the script window, or 20 if the script window is suppressed. Setting output .height to 0
has the same effect as setting console.output to TRUE.

output .text.color Color for output in the output window; the default is "blue".

placement Placement of the R Commander window, in pixels; the defaultis "-40+20", which
puts the window near the upper-right corner of the screen.
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plugins A character vector giving the names of Remdr plug-in packages to load when the Com-
mander starts up. Plug-in packages can also be loaded from the Tools -> Load Rcmdr plug-
in(s) menu. See Plugins.

suppress.menus if TRUE, the Commander menu bar and tool bar are suppressed, allowing an-
other program (such as Excel) to take over these functions. The default (of course) is FALSE.

suppress.X1ll.warnings On (some?) Linux systems, multiple X11 warnings are generated
by Remdr commands after a graphics-device window has been opened. Set this option to
TRUE (the default when running interactively under X11 prior to R version 2.4.0) to suppress
reporting of these warnings. An undesirable side effect is that then all warnings and error
messages are intercepted by the Remdr, even those for commands entered at the R command
prompt. Messages produced by such commands will be printed in the Commander Messages
window after the next Rcmdr-generated command. Some X11 warnings may be printed when
you exit from the Commander. This problem only applies to R versions before 2.4.0, and the
default value of the option is set accordingly.

retain.messages If TRUE (the default is FALSE), the contents of the message window are
not erased between messages. In any event, a "NOTE" message will not erase a preceding
"WARNING" or "ERROR".

RExcelSupport If TRUE (the default is FALSE), menus and output are handled by Excel.

scale. factor A scaling factor to be applied to all Tk elements, such as fonts. This works well
only in Windows. The default is NULL.

showData.threshold If the number of variables in the active data set exceeds this value (de-
fault, 100), then edit () rather than showData () is used to display the data set. A disad-
vantage is that control doesn’t return to the Commander until the edit window is closed. The
reason for the option is that showData () is very slow when the number of variables is large;
setting the threshold to O suppresses the use of showData altogether.

show.edit .button Set to TRUE (the default) if you want an Edit button in the Commander
window, permitting you to edit the active data set. Windows users may wish to set this option
to FALSE to suppress the Edit button because changing variable names in the data editor can
cause R to crash (though I believe that this problem as been solved).

sort .names Setto TRUE (the default) if you want variable names to be sorted alphabetically in
variable lists.

tkwait This option addresses a problem that, to my knowledge, is rare, and may occur on some
non-Windows systems. If the Commander causes R to hang, then set the tkwait option to
TRUE; otherwise set the option to FALSE or ignore it. An undesirable side effect of setting
the tkwait option to TRUE is that the R session command prompt is suppressed until the
Commander exits. One can still enter commands via the script window, however. In partic-
ular, there is no reason to use this option under Windows, and it should not be used with the
Windows R GUI with buffered output when output is directed to the R console.

use.rgl If TRUE (the default), the rgl package will be loaded if it is present in an accessible
library; if FALSE, the rgl package will be ignored even if it is available. The rgl package
can sometimes cause problems when running R under X11.

warning.text.color Color for warning messages; the default is "darkgreen™".

Many options can also be set via the File -> Options menu, which will restart the Commander after
options are set.
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Warning

The R Commander Script window does not provide a true console to R, and has certain limitations.
I don’t recommend using the R Commander for serious programming or for data analysis that relies
primarily on scripts — use a programming editor instead. For example, compound R statements
enclosed in braces " { } ", including in function defintions, will not be parsed and executed correctly,
even if lines after the first are indented. You can execute compound statements from the Script
window by separating commands within braces by semicolons.

Known Problem

Occasionally, under Windows, after typing some text into a dialog box (e.g., a subsetting expression
in the Subset Data Set dialog), buttons in the dialog (e.g., the OK button) will have no effect when
they are pressed. Clicking anywhere inside or outside of the dialog box should restore the function
of the buttons. As far as I have been able to ascertain, this is a problem with Tcl/Tk for Windows.

Note

This version may be compatible with SciViews, which currently runs only under Windows systems:
http://www.sciviews.org/SciViews—R; see Rcmdr.sciviews—specific. Under
Windows, the Remdr package can also be run under the Rgui in SDI (single-document interface)
mode, or under rterm.exe; you might experience problems running the Remdr under ESS with-
NTEmacs or XEmacs.

Author(s)

John Fox (jfox@mcmaster.ca)

See Also

Plugins

Examples

options (Remdr=1list (log.font.size=12, contrasts=c("contr.Sum", "contr.poly")))

Compute Remdr Compute Dialog

Description

The compute dialog is used to compute new variables.

Details

The name of the new variable must be a valid R object name (consisting only of upper and lower-
case letters, numerals, and periods, and not starting with a numeral).

Enter an R expression in the box at the right. The expression is evaluated using the active data
set. You can double-click in the variable-list box to enter variable names in the expression. The
expression must evaluate to a valid variable, which is added to the active data set.


http://www.sciviews.org/SciViews-R
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Author(s)

John Fox (jfox@mcmaster.ca)

See Also

Arithmetic

dozenl? Random data with 12 conditions and 1 outcome

Description

The data was randomly generated using set.seed(12)

Usage

data (dozenl?2)

Ebbinghaus Union Growth and Decline in Western Europe 1950-95

Description

The Ebbinghaus data frame has 13 rows and 10 columns.

During the early post-war period, Western trade union movements grew in membership and achieved
an institutionalized role in industrial relations and politics. However, during the last decades, many
trade unions have seen their membership decline as they came increasingly under pressures due to
the social, economic and political changes. This article reviews the main structural, cyclical and
institutional factors explaining union growth and decline. Concentrating on Western Europe, the
empirical analysis compares cross-national union density data for 13 countries over the first period
(1950-75) and for 16 countries over the second, “crisis” period (1975-95)

Usage

data (Ebbinghaus)



14 generalizedLinearModel

Format

The dataset contains the following columns:

ouT union decline (outcome variable)
GHENT country with "Ghent-system” (union led unemployment insurance)
WORKACCESS  workplace access for unions
NEOCORP neo-corporatist institutionalization of unions
CLOSHOP “closed-shop” tradition
SOCDEM government participation of Social-Democratic / Socialist party
INDUS share of industry in dependent unemployment
PUBLIC share of public sector development employment
UNEMPL average unemployment rate
INFLA average inflation rate
Source

http://www.compasss.org

References

Ebbinghaus, Bernhard and Visser, Jelle 2000 Trade Unions in Western Europe since 1945. In Flora,
P. and Rothenbacher, Kraus F. (eds.) The Societies of Europe Series, London: Macmillan Reference
/ Palgrave, March 2000 / New York: Grove’s Dictionaries / Palgrave, July 2000 [xxii, 808 pp. and
CD-ROM]

evenll Random data with 11 conditions and 1 outcome

Description

The data was randomly generated using set.seed(11)

Usage

data (evenll)

generalizedLinearModel
Remdr Generalized Linear Model Dialog

Description

This dialog is used to specify a generalized linear model to be fit by the g1m function.


http://www.compasss.org
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Details

The left model-formula box specifies the response variable to be used in the model; it may be a vari-
able name or an expression evaluating to the response variable, such as working == "Fulltime".

The right model-formula box specifies the right-hand (i.e., predictor) side of the model. See glm
for details.

You can type directly in the model formula boxes. Alternatively, double-clicking the left mouse
button on a variable in the variable-list transfers it to the left-hand side of the model (if it is empty)
or to the right-hand side. Factors are indicated in the variable list; all other variables are numeric.
You can also enter operators and parentheses using the buttons above the formula.

Double-click the left mouse button to select a family in the "Family" box and the corresponding
permissible link functions appear in the "Link function" box to the right. Initially, the canonical
link for the family is selected. See family for details.

Specifying a subset expression allows you to fit the model to a subset of observations in the active
data set. For example, assuming that gender is a variable in the active data set, entering gender
== "Male" would restrict the model to males.

If the active model is a generalized linear model, and the active data set has not changed, then the
initial values of the left-hand-side, right-hand-side, family, link, and subset fields are retained from
the active model.

Author(s)

John Fox (jfox@mcmaster.ca)

See Also

glm, family, Comparison

hierarchicalCluster
Rcmdr Hierarchical Clustering Dialog

Description

This dialog is used to specify a hierarchical cluster analysis solution using hclust, with the dis-
tance matrix calculated using dist.

Details

Enter a name for the hierarchical clustering solution to be created if you want to retain more than
one solution. The solution name must be a valid R object name (consisting only of upper- and
lower-case letters, numerials, and periods, and not starting with a number).

Select the variables to be included in the solution using the variable selection box on the left side
of the dialog box. A non-contiguous set of variables can be selected by pressing your control key
(ctrl) while selecting variables.
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Specifying a subset expression (the field below the variable selection box) allows you to obtain a
clustering solution for a subset of observations in the active data set. For example, assuming that
gener is a variable in the active data set, entering gender == "Male" would restrict the solution
to males.

Select a clustering method and a distance measure if you are working with raw data. There is often
a relationship between the selection of these two items. For example, squared-euclidian distance is
appropriate for Ward’s method of cluster analysis. If your data is a distance matrix, then select "No
Transformation" as the distance measure.

The "Plot Dendrogram" option results in the dendrogram of the solution being display by using the
plot function.

Author(s)

Dan Putler

See Also

hclust, dist

Hist Plot a Histogram

Description

This function is a wrapper for the hist function in the base package, permitting percentage
scaling of the vertical axis in addition to frequency and density scaling.

Usage
Hist (x, scale = c("frequency", "percent", "density"), ...)
Arguments
X a vector of values for which a histogram is to be plotted.
scale the scaling of the vertical axis: "frequency" (the default), "percent", or
"density".
arguments to be passed to hist.
Value

This function returns NULL, and is called for its side effect — plotting a histogram.

Author(s)

John Fox (jfox@mcmaster.ca)
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See Also
hist

Examples

data (Prestige)
Hist (Prestige$income, scale="percent")

KMeans K-Means Clustering Using Multiple Random Seeds

Description

Finds a number of k-means clusting solutions using R’s kmeans function, and selects as the final
solution the one that has the minimum total within-cluster sum of squared distances.

Usage

KMeans (x, centers, iter.max=10, num.seeds=10)

Arguments
X A numeric matrix of data, or an object that can be coerced to such a matrix (such
as a numeric vector or a dataframe with all numeric columns).
centers The number of clusters in the solution.
iter.max The maximum number of iterations allowed.
num. seeds The number of different starting random seeds to use. Each random seed results
in a different k-means solution.
Value

A list with components:

cluster A vector of integers indicating the cluster to which each point is allocated.
centers A matrix of cluster centres (centroids).
withinss The within-cluster sum of squares for each cluster.

tot.withinss The within-cluster sum of squares summed across clusters.

betweenss The between-cluster sum of squared distances.
size The number of points in each cluster.
Author(s)

Dan Putler
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See Also

kmeans

Examples

data (USArrests)
KMeans (USArrests, centers=3, iter.max=5, num.seeds=5)

linearModel Rcemdr Linear Model Dialog

Description

This dialog is used to specify a linear model to be fit by the 1m function.

Details

The left model-formula box specifies the response variable to be used in the model; it may be a
variable name or an expression evaluating to the response variable, such as 1og (income).

The right model-formula box specifies the right-hand (i.e., predictor) side of the model. See 1m for
details.

You can type directly in the model formula boxes. Alternatively, double-clicking the left mouse
button on a variable in the variable-list transfers it to the left-hand side of the model (if it is empty)
or to the right-hand side. You can also enter operators and parentheses using the buttons above the
formula.

Specifying a subset expression allows you to fit the model to a subset of observations in the active
data set. For example, assuming that gender is a variable in the active data set, entering gender
== "Male" would restrict the model to males.

If the active model is a linear model and the active data set has not changed, then the initial values
of the left-hand-side, right-hand-side, and subset fields are retained from the previous model.

Author(s)

John Fox (jfox@mcmaster.ca)

See Also

1m, Comparison
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luckyl3 Random data with 13 conditions and 1 outcome

Description

The data was randomly generated using set.seed(13)

Usage

data (luckyl3)

MI.15 Random data with 15 conditions and 1 outcome

Description

The data was randomly generated using set.seed(15) "MI” stands for Mission Impossible

Usage

data (MI.1l5)

mightyl4 Random data with 14 conditions and 1 outcome

Description

The data was randomly generated using set.seed(14)

Usage

data (mightyl4)



20 numSummary

numSummary Mean, Standard Deviation, and Quantiles for Numeric Variables

Description

numSummary creates neatly formatted tables of means, standard deviations, and quantiles of nu-
meric variables.

Usage
numSummary (data, statistics=c("mean", "sd", "quantiles"),

quantiles=c (0, .25, .5, .75, 1), groups)

## S3 method for class 'numSummary':
print(x, ...)

Arguments

data a numeric vector, matrix, or data frame.

statistics any of "mean", "sd", or "quantiles", defaulting to all three.

quantiles quantiles to report; defaultis c (0, 0.25, 0.5, 0.75, 1).
groups optional variable, typically a factor, to be used to partition the data.
x object of class "numSummary" to print.

arguments to pass down from the print method.

Value

numSummary returns an object of class "numSummary" containing the table of statistics to be
reported along with information on missing data, if there are any.

Author(s)

John Fox (jfox@mcmaster.ca)

See Also

mean, sd, quantile.

Examples

library (car)

Prestige[l, "income"] <- NA
numSummary (Prestige[, c("income", "education")])
numSummary (Prestige[, c("income", "education")], groups=PrestigeS$type)

remove (Prestige)
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Osa

Political Opportunity in Non-democracies

Description

The Osa data frame has 24 rows and 6 columns.

This data is drawn from a study which analyzes twenty-four cases of occurrence/non-occurrence
of mobilization in non-democratic states to determine conditions of political opportunity in high-
risk authoritarian contexts. Political opportunity is sensitive to conditions created by divided elites,
changes in repression, media access, influential allies, and social networks

Usage

data (Osa)

Format

The dataset contains the following columns:

DYNA

ACCESS

INFLU

ELITE

SOCIAL

ouT

Source

Dynamics of repression, coded 1 for evidence of increase in long-term and/or short-term
state repression, 0 for evidence of decrease

Media access - coded 1 if the public information flow concerning a particular event
of popular mobilization is controlled by the political authorities (via censorship

or ban on foreign media), O if there was evidence of sustained relaxation of state
censorship or substantive presence of foreign and/or underground media

Influential allies - coded 1 for presence of domestic or foreign politically

influential groups supporting popular mobilization; 0 for absence of such
organizational support

Division of elites, coded 1 - evidence of competing factions within the ruling elites;
0 - relatively unified ruling group

Social networks - coded 1if mobilization resulted from the activity of interconnected
groups, 0 if organizational and/or individual ties were severely destroyed or impeded
to emerge by the state

Social mobilization, coded 1 for major episodes of sustained collective action
opposing state policies by participants drawn from nonelite or repressed segments
of society in non-democratic regimes, 0 - non-mobilization

http://www.compasss.org

References

Osa, Maryjane and Corduneanu-Huci, Cristina 2003 Running Uphill: Political Opportunity in Non-
democracies, Comparative Sociology 2(4), pp. 605-629(25)


http://www.compasss.org
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partial.cor Partial Correlations

Description

Computes a matrix of partial correlations between each pair of variables controlling for the others.

Usage

partial.cor (X, ...)

Arguments
X data matrix.
arguments to be passed to cor.
Value

Returns a matrix of partial correlations.

Author(s)

John Fox (jfox@mcmaster.ca)

See Also

cor

Examples

data (DavisThin)
partial.cor (DavisThin)

plotMeans Plot Means for One or Two-Way Layout

Description

Plots cell means for a numeric variable in each category of a factor or in each combination of
categories of two factors, optionally along with error bars based on cell standard errors or standard
deviations.
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Usage
plotMeans (response, factorl, factor2,
error.bars = c("se", "sd", "conf.int", "none"), level=0.95,
xlab = deparse(substitute(factorl)),
ylab = paste("mean of", deparse(substitute (response))),
legend.lab = deparse (substitute(factor2)), main = "Plot of Means",

pch = 1:n.levs.2, lty = l:n.levs.2, col = palette())

Arguments
response Numeric variable for which means are to be computed.
factorl Factor defining horizontal axis of the plot.
factor2 If present, factor defining profiles of means

error.bars

level

xlab

ylab
legend.lab
main

pch

1ty

col

Value

If "se", the default, error bars around means give plus or minus one standard
error of the mean; if "sd", error bars give plus or minus one standard deviation;
if "conf.int", error bars give a confidence interval around each mean; if
"none", error bars are suppressed.

level of confidence for confidence intervals; default is .95
Label for horizontal axis.

Label for vertical axis.

Label for legend.

Label for the graph.

Plotting characters for profiles of means.

Line types for profiles of means.

Colours for profiles of means

The function invisibly returns NULL.

Author(s)

John Fox (jfox @mcmaster.ca)

See Also

interaction.plot
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Plugins R Commander Plug-in Packages

Description

Plug-ins are R packages that extend the R Command interface.

Details

An R Commander plug-in is an ordinary R package that (1) provides extensions to the R Comman-
der menus is a file named menus . txt located in the package’s et c directory; (2) provides call-
back functions required by these menus; and (3) in optional Log-Exceptions: and Models:
fields in the package’s DESCRIPTION file, augments respectively the list of functions for which
printed output is suppressed and the list of model objects recognized by the R Commander. The
menus provided by a plug-in package are merged with the standard Commander menus.

Plug-in packages given in the R Commander plugins option (see Commander) are automatically
loaded when the Commander starts up. Plug-in packages may also be loaded via the Commander
Tools -> Load Rcmdr plug-in(s) menu; a restart of the Commander is required to install the new
menus. Finally, loading a plug-in package when the Remdr is not loaded will load the Remdr and
activate the plug-in.

An illustrative R Commander plug-in package, RemdrPlugin.TeachingDemos, is available on
CRAN.

See Also

Commander

Rcmdr.sciviews—-specific
Rcmdr SciViews-specific Functions

Description

These functions provide compatibility with SciViews (http://www.sciviews.org). Thanks
to them, Remdr is totally integrated into SciViews Insider. In this environment, the main 'R Com-
mander’ window is replaced by an 'R Commander menu’ and log files are replaced by special R
code editing windows with syntax highlighting. Most of these functions are not intended for direct
use.


http://www.sciviews.org
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Usage

is.SciViews ()
is.SciViews.TclTk ()
svlogger (command)
optionLogCommand ()
optionAttachDataSet ()
optionSortVariables ()
refreshStatus ()

Arguments

command a character string that evaluates to an R command.

Details

The functions is.SciViews tests if R is running under SciViews. If not, most of the other
SciViews-specific functions do nothing. is.SciViews.TclTk test if the SciViews client com-
municates with R through Tcl/Tk (otherwise, it probably uses SciViews plugs). The function
svlogger is similar to logger, but it records Recmdr commands in the specific SciViews R script
window and in the SciViews command history, instead of the log window and the default R com-
mand history. optionLogCommand, optionAttachDataSet and optionSortVariables
allow to change the command logging, automatic attachment of the active data set and sorting of
variable names (equivalent options than those accessible by check boxes in the 'R Commander’
window of Remdr outside of SciViews, or in the Options dialog box). In SciViews insider, the state
of these options, as well as the names of the active data set and model are displayed in the status
bar. refreshStatus make sure that this information in the status bar is updated according to the
current internal state of Rcmdr.

Author(s)

Philippe Grosjean (phgrosjean@sciviews.org)

Rcmdr.Utilities Rcmdr Utility Functions

Description

These functions support writing additions to the Rcmdr package. Additional R code can be placed
in files with file type . R in the et c subdirectory of the package. Add menus, submenus, and menu
items by editing the file Recmdr-menus . txt in the same directory.

Usage

activateMenus (
activeDataSet (
ActiveDataSet (
activeDataSetP

ame)

)
dsname, flushModel=TRUE)
n
()
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activeModel (model)
ActiveModel (name)

activeModelP ()

checkActiveDataSet ()

checkActiveModel ()

checkBoxes (window=top, frame, boxes, initialValues=NULL, labels) # macro
checkClass (object, class, message=NULL) # macro

checkFactors (n=1)

checkMethod (generic, object, message=NULL, default=FALSE, strict=FALSE,
reportError=TRUE) # macro

checkNumeric (n=1)

checkReplace (name, type=gettextRcmdr ("Variable"))

checkTwoLevelFactors (n=1)

checkVariables (n=1)

closeCommander (ask=TRUE, ask.save=ask)

closeDialog(window, release=TRUE) # macro

CommanderWindow ()

dataSetsP ()

defmacro (..., expr)

dialogSuffix (window=top, onOK=onOK, rows=1l, columns=1l, focus=top, bindReturn=TRUE,
preventGrabFocus=FALSE, preventDoubleClick=FALSE, preventCrisp=FALSE) # macro

doItAndPrint (command, log=TRUE)

errorCondition (window=top, recall=NULL, message, model=FALSE) # macro

exists.method (generic, object, default=TRUE, strict=FALSE)

Factors (names)

factorsP (n=1)

## S3 method for class 'listbox':

getFrame (object)

## S3 method for class 'listbox':

getSelection (object)

getRcmdr (x, mode="any")

gettextRcmdr (...)

glmP ()

GrabFocus (value)

groupsBox (recall=NULL, label=gettextRcmdr ("Plot by:"),
initiallabel=gettextRcmdr ("Plot by groups"),
plotLinesByGroup=FALSE, positionLegend=FALSE,
plotLinesByGroupsText=gettextRcmdr ("Plot lines by group")) # macro

groupsLabel (frame=top, groupsBox=groupsBox, columnspan=1) # macro

hclustSolutionsP ()

initializeDialog(window=top, title="", offset=10, preventCrisp=FALSE) # macro

is.valid.name (xX)

justDoIt (command)

listAllModels (envir=.GlobalEnv, ...)

listDataSets (envir=.GlobalEnv, ...)

listFactors (dataSet=ActiveDataSet ())

listGeneralizedLinearModels (envir=.GlobalEnv, ...)

listLinearModels (envir=.GlobalEnv, ...)
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listMultinomiallLogitModels (envir=.GlobalEnv, ...)

listNumeric (dataSet=ActiveDataSet ())

listPlugins (loaded=FALSE)

listProportionalOddsModels (envir=.GlobalEnv, ...)

listTwoLevelFactors (dataSet=ActiveDataSet ())

listVariables (dataSet=ActiveDataSet ())

1mP ()

logger (command)

LogWindow ()

Message (message, type=c("note", "error", "warning"))

MessagesWindow ()

modelFormula (frame=top, hasLhs=TRUE) # macro

modelsP (n=1)

Numeric (names)

numericP (n=1)

OKCancelHelp (window=top, helpSubject=NULL, model=FALSE) # macro

OutputWindow ()

packageAvailable (name)

putRcmdr (x, value)

radioButtons (window=top, name, buttons, values=NULL, initialValue=..values[1l],
labels, title) # macro

RcmdrTclSet (name, value)

RcmdrTkmessageBox (message, icon=c("info", "question", "warning",
"error"), type=c("okcancel", "yesno", "ok"), default, title="")

rglLoaded ()
subOKCancelHelp (window=subdialog, helpSubject=NULL) # macro
subsetBox (window=top, model=FALSE) # macro

trim.blanks (text)

TwolevelFactors (names)

twoLevelFactorsP (n=1)

UpdateModelNumber (increment=1)

variablelListBox (parentWindow, variableList=Variables(), bg="white",
selectmode="single", export="FALSE", initialSelection=NULL,
listHeight = 4, title)

Variables (names)

# the following function is exported for technical reasons,
# but is not meant to be called directly

commanderPosition ()

Arguments
ask ask for confirmation
ask.save ask whether to save contents of script and output windows.
bg background color.

bindReturn  if TRUE, the Return key is bound to the onOK function in the dialog.
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boxes

buttons
class
columnspan

command

Rcemdr. Utilities

vector of quoted names for check boxes, used to generate each box and its asso-
ciated variable.

vector of quoted names for buttons in a set of related radio buttons.
quoted name of class.
number of dialog-box columns to be spanned by frame.

a character string that evaluates to an R command.

dataSet, dsname

default

envir
export
expr

flushModel

focus

frame
generic
groupsBox
hasLhs
helpSubject

icon

increment

the quoted name of a data frame in memory.

default button: if not specified, "ok" for "okcancel", "yes" for "yesno", and "ok"
for "ok"; or look for a default method.

the environment to be searched; should generally be left at the default.
export selection?
expression constituting the body of the macro; typically a compound expression.

set (or reset) the active model to NULL? Should normally be TRUE when the
active data set is changed; an exception is when variables are simply added to,
deleted from, or modified in the data set set.

Tk window to get the focus.

frame or quoted name for frame depending upon the function.
quoted name of generic function.

listbox object for selecting groups variable.

does the model formula have a left-hand side?

the quoted name of a help subject, to be called ashelp (helpSubject) when
the dialog Help button is pressed.

Message-box icon.

increment to model number; -1 to set back after error.

initialLabel label for groups button before a selection is made.

initialSelection

index of item initially selected, 0-base indexing.

initialValue for a set of related radio buttons.
initialValues

label
labels
listHeight
loaded

log
message

mode

for a set of related check boxes.

label prefix for groups button after a selection is made.

a vector of character strings to label a set of radio buttons or check boxes.
Maximum number of elements displayed simultaneously in list box.

if TRUE, plug-in packages that are loaded are included in the vector of names
returned.

echo command to the log window, as well as executing it and printing its output.
error (or other) message.

mode of object to retrieve.
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model the name of a model, as a character string, or TRUE or FALSE, depending upon
the function.

name quoted name.

names optional names to be stored.

n number of items to check for.

object an object (depends on context).

offset in pixels, from top-left of Commander window.

onOK function to execute when the OK button is pressed.

plotLinesByGroup

include a check box for plotting lines by group?
plotLinesByGroupsText
the label for the plot-lines-by-group check box.
positionLegend
include a check box for a legend?
preventGrabFocus
prevent the dialog box from grabbing the focus.
preventDoubleClick
prevent double-clicking from pressing the OK button, even when the double.click
option is set; necessary for statistical modelling dialogs, which use double-
clicking to build the model formula.

preventCrisp prevent call to tclServiceMode, which (rarely) causes problems with some

dialogs.
recall function to call after error — usually the function that initiates the dialog.
release release the focus if the grab.focus option has been set.

reportError if TRUE, report an error message.
rows, columns
numbers of rows and columns of widgets in the dialog box.

values vector of quoted values associated with radio buttons or check boxes.
selectmode "single" or "multiple".

strict if TRUE, only use first element of class vector.

text a text string.

title Window or dialog-box-element title.

type quoted type of object to check; used to generate check-replace dialog box; or

type of message to print in Message window.
value an object to be stored.

variableList a vector of variable names.
window, parentWindow

a Tk window.
x an R object name, as a character string.

For gettextRcmdr, text string or vector of text strings to translate; for de fmacro,
arguments for the macro; otherwise disregard.
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Details

There are several groups of functions exported by the Remdr package and documented briefly here.
To see how these functions work, it is simplest to examine the dialog-generating functions in the
Rcmdr package.

Executing and logging commands: The functions doItAndPrint, justDoIt, and logger

control the execution, logging, and printing of commands generated by menus and dialogs. 1ogger (command)
adds command to the log/script window and to the output window. justDoIt (command)

causes command to be executed. doItAndPrint (command) does both of these operations,

and also prints the output produced by the command.

Checking for errors: The function is.valid.name checks whether a character string specifies

a valid name for an R object. The functions checkActiveDataSet, checkActiveModel,
checkFactors, checkNumeric, checkTwoLevelFactors,and checkVariables check
for the existence of objects and write an error message to the log if they are absent (or insufficiently
numerous, in the case of different kinds of variables). The function checkReplace opens a dia-
log to query whether an existing object should be replaced. The function checkMethod, checks
whether a method exists for a particular generic that is appropriate for a particular object. The func-
tion checkClass checks whether an object is of a specific class. Both of these functions write
error messages to the log if the condition fails. The function errorCondition reports an error
to the user and (optionally) re-starts a dialog.

Information: Several functions return vectors of object names: 1istAl1lModels,
listDataSets,listGeneralizedLinearModels, listFactors,listLinearModels,
listMultinomiallLogitModels, listNumeric, listProportionalOddsModels,
listTwoLevelFactors, listVariables. The functions activeDataSet and activeModel
respectively report or set the active data set and model. The function packageAvailable re-

ports whether the named package is available to be loaded (or has possibly already been loaded).

The function exists.method checks whether a method exists for a particular generic that is
appropriate for a particular object, and returns TRUE or FALSE.

Building dialog boxes: Several functions simplify the process of constructing Tk dialogs: ini-
tializing a dialog box, initializeDialog, and completing the definition of a dialog box,
dialogSuffix; a set of check boxes, checkBoxes; a set of radio buttons, radioButtons;
a list box with associated scrollbars and state variable, variablelListBox (and the associated
functions getFrame and getSelection); a button and subdialog for selecting a "grouping"
variable, groupsBox; displaying the currently defined groups in a dialog, groupsLabel; a
dialog-box structure for entering a model formula, mode1Formula; a text box for entering a sub-
setting expression, subsetBox; OK, Cancel, and Help buttons for dialogs, OKCancelHelp, and
subdialogs, subOKCancelHelp.

Translating text: The get textRcmdr function simply passes its argument(s) to get text, adding
the argument domain="R-Rcmdr".

Miscellaneous: The function trim.blanks removes spaces from the beginning and end of a
character string. The function installPlugin installs an Remdr plug-in from a ZIP file or
directory; this function may be used to create self-installing plug-ins in the form of packages.

Some of these functions, marked # macro under Usage, are "macro-like" in their behaviour, in
that they execute in the environment from which they are called. These were defined with an
adaptation (used with permission) of Thomas Lumley’s de fmacro function, described in Lumley
(2001).
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Author(s)

John Fox (jfox@mcmaster.ca)

References

T. Lumley (2001) Programmer’s niche: Macros in R. R News, 1(3), 11-13.

RcmdrPager Pager for Text Files

Description

This is a slightly modified version of the tkpager, changed to use the Rcmdr monospaced font and
a white background.

Usage

RcmdrPager (file, header, title, delete.file)

Arguments
file character vector of file(s) to be displayed.
header for the beginning of each file.
title for window

delete.file delete file(s) on close.

See Also

tkpager

Recode Rcmdr Recode Dialog

Description

The recode dialog is normally used to recode numeric variables and factors into factors, for example
by combining values of numeric variables or levels of factors. It may also be used to produce new
numeric variables. The Remdr recode dialog is based on the recode function in the car package.
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Details

The name of each new variable must be a valid R object name (consisting only of upper and lower-
case letters, numerals, and periods, and not starting with a numeral).

Enter recode directives in the box near the bottom of the dialog. Directives are normally entered
one per line, but may also be separated by semicolons. Each directive is of the form input =
output (see the examples below). If an input value satisfies more than one specification, then the
first (from top to bottom, and left to right) applies. If no specification is satisfied, then the input
value is carried over to the result. NA is allowed on input and output. Factor levels are enclosed in
double-quotes on both input and output.

Several recode specifications are supported:

a single value For example, "missing" = NA.

several values separated by commas For example, 7,8, 9 = "high".

a range of values indicated by a colon For example, 7:9 = "high". The special values 1ow
and high may appear in a range. For example, 1ow:10=1. Note that these values are
unquoted.

the special value else everything that does not fit a previous specification. For example, e1 se=NA.
Note that e 1 se matches all otherwise unspecified values on input, including NA.

If all of the output values are numeric, and the "Make new variable a factor" check box is unchecked,
then a numeric result is returned.

If several variables are selected for recoding, then each is recoded using the same recode directives.
In this case, the name entered in the box labelled "New variable name or prefix for multiple recodes"
will be prefixed to the name of each variable being recoded. Setting an empty prefix (i.e., "") will
cause the recoded variables to replace the original variables.

Author(s)

John Fox (jfox @mcmaster.ca)

See Also

recode

reliability Reliability of a Composite Scale

Description

Calculates Cronbach’s alpha and standardized alpha (lower bounds on reliability) for a composite
(summated-rating) scale. Standardized alpha is for the sum of the standardized items. In addition,
the function calculates alpha and standardized alpha for the scale with each item deleted in turn,
and computes the correlation between each item and the sum of the other items.
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Usage

reliability (S)

## S3 method for class 'reliability':

print (x, digits=4, ...)
Arguments
S the covariance matrix of the items; normally, there should be at least 3 items and

certainly no fewer than 2.
X reliability object to be printed.
digits number of decimal places.

not used: for compatibility with the print generic."

Value

an object of class reliability, which normally would be printed.

Author(s)

John Fox (jfox@mcmaster.ca)

References

N. CIiff (1986) Psychological testing theory. Pp. 343-349 in S. Kotz and N. Johnson, eds., Ency-
clopedia of Statistical Sciences, Vol. 7. Wiley.

See Also

cov

Examples

data (DavisThin)
reliability (cov(DavisThin))

Rokkan Divided Working-Class Movements
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Description

The Rokkan data frame has 16 rows and 5 columns.

Abridged from Ragin (1987):

The data was used by Rokkan (1970) in his work on nation building in Western Europe. Rokkan
used a “configurational” approach that bears many similarities to the Boolean approach presented
in this work. His main substantive interest was the growth of mass democracy and the emergence
of different cleavage structures in Western European polities. One outcome that interested him was
the division of some working-class movements in these countries following the Russian Revolution
into internationally oriented wings and some into nationally oriented wings. He considered the
distribution of this outcome important because of its implication for the future of working-class
mobilization (and cleavage structures in general) in Western Europe

Usage

data (Rokkan)

Format

The dataset contains the following columns:

- National church (vs. state allied to Roman Catholic church)

- Significant Roman Catholic population and Roman Catholic participation in mass education
State protection of landed interests

- Early state

- Major split in working-class movement provoked by Russian Revolution (outcome variable)
(yes/no)

nme AN

Source

Ragin, Charles C. 1987 The Comparative Method. Moving beyond qualitative and quantitative
strategies, Berkeley: University of California Press, pp.129

References

Rokkan, Stein 1970 Citizens, Elections, Parties, New York: McKay

stem.leaf Stem-and-Leaf Display

Description

Creates a classical ("Tukey-style") stem-and-leaf display.
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Usage
stem.leaf (data, unit, m, Min, Max,
rule.line = c("Dixon", "Velleman", "Sturges"),
style = c("Tukey", "bare"), trim.outliers = TRUE, depths = TRUE,
reverse.negative.leaves = TRUE)

## S3 method for class 'stem.leaf':

print(x, ...)
Arguments

data a numeric vector.

unit leaf unit, as a power of 10 (e.g., 100, . 01); omit to let the function choose the
unit.

m number of parts (1, 2, or 5) into which each stem should be divided; omit to let
the function choose the number of parts/stem.

Min smallest non-outlying value; omit for automatic choice.

Max largest non-outlying value; omit for automatic choice.

rule.line the rule to use for choosing the desired number of lines in the display; "Dixon"

= 10*logl0(n); "Velleman" = 2*sqrt(n); "Sturges" =1 + log2(n); the
defaultis "Dixon™".

style "Tukey" (the default) for "Tukey-style" divided stems; "bare" for divided
stems that simply repeat the stem digits.

trim.outliers
if TRUE (the default), outliers are placed on L.O and HI stems.

depths if TRUE (the default), print a column of "depths" to the left of the stems; the
depth of the stem containing the median is the stem-count enclosed in parenthe-
ses.

reverse.negative.leaves

if TRUE (the default), reverse the leaves on negative stems (so, e.g., the leaf 9
comes before the leaf 8, etc.).

X an object of class stem.leaf to be printed.

not used: for compatibility with the generic print function.

Details

Unlike the stem function in the base package, this function produces classic stem-and-leaf dis-
plays, as described in Tukey’s Exploratory Data Analysis. Outliers are determined using the rule
for boxplots (see boxplot.stats).

Value

Returns on object of class stem.leaf, which normally would be printed.
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Author(s)
Peter Wolf, slightly modified by John Fox (jfox @mcmaster.ca) with the original author’s permis-
sion.

References

Tukey, J. Exploratory Data Analysis. Addison-Wesley, 1977.

See Also

stem

Examples

data (Prestige)
stem.leaf (Prestige$income)

Stokke Causal mechanisms and regime effectiveness

Description

The Stokke data frame has 9 rows and 6 columns.

The purpose of introducing mechanisms in regime research, is partly to allow detailed examination
of the various ways in which regimes may affect behaviour: this could be coined a magnifying
purpose. The second objective is the methodological one of facilitating systematic comparison of
cases by constituting them in ways that make them sufficiently homogeneous to permit employment
of available comparative techniques. The cases presented in this data stress on “shaming” as a causal
mechanism for international resource management. Shaming highlights attempts to bring about a
change in problem-related behaviour not by material rewards or punishment but by exposing certain
practices to third parties whose opinion matters to the target of shaming

Usage

data (Stokke)

Format

The dataset contains the following columns:

- Advice

- Commitment

Shadow of the future

- Inconvenience

- Reverberation

- Success (outcome variable)

KA A
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Source

http://www.compasss.org

References

Stokke, Olav Schram 2004 Boolean Analysis, Mechanisms, and the Study of Regime Effectiveness
in Underdal, Arild and Young, Oran R. (eds.) Methodological Challenges and Research Strategies
Dordrecht: Kluwer Academic, pp. 87-119

Yamasaki The problem of contradictory simplifying assumptions

Description

The Yamasaki data frame has 6 rows and 6 columns.

In Qualitative Comparative Analysis (QCA) of social data, the generation of parsimonious explana-
tory equations is enhanced by the inclusion of “logical configurations”. Even if this procedure
proves to be very useful, it also raises various methodological issues. Among them, the tricky prob-
lem of “contradictory simplifying assumptions” has remained largely unexplored. Yet the careful
control of this obstacle is crucial for any QCA to be successful, not only because contradictory
assumptions are inducing wrong conclusions, but also because their resolution can generate most
interesting results. Hence, our contribution aims at enlightening this difficulty, as well as designing
an efficient way to overcome it. In this perspective, we start from data collected for a compara-
tive research on “’the political feasibility of an unconditional basic income” in six OECD countries
(1980-2002). After having briefly stated the core elements of the research question, six operational
variables are defined (section 1). On this basis, we conduct a Boolean analysis and comment the
various ’feasibility scenarios’ generated by the QCA 3.0 software (section 2). Starting from these
first results, we identify contradictory simplifying assumptions used by the software, and discuss
possible solutions to this problem. New results are then generated (section 3). In the conclusion,
we shortly discuss the general implications of this methodological problem

Usage

data (Yamasaki)

Format

The dataset contains the following columns:

POSTMAT the level of postmodern values in a society takes the value ”’1” in the Dutch
and Finnish cases, and ”0” in the others

NONGHENT the absence of a Ghent system is coded 1" and ”0” when the Ghent system
exists in the country

MOVEMENT in the presence of a social movement advocating Basic Income, the variable
will be coded 1~

UNITARY based on the Lijphart index (1.0 to 5.0, from unitary to federal and
decentralised states), the variable is coded 0 for cases in the three
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following categories: semi-federal states (3.0), federal and centralized
states (4.0), and federal and decentralized states (5.0), and 1" otherwise.

SOCIAL based on Esping-Andersen’s categorisation of welfare regimes, the variable
is coded ”’1” for non-liberal countries and 0 otherwise
AGENDA the outcome variable, coded ’1” when Basic Income has been considered as a

serious alternative at the governmental level

Source

http://www.compasss.org

References

Vanderborght, Yannick and Yamasaki, Sakura 2003 The Problem of Contradictory Simplifying As-
sumptions in Qualitative Comparative Analysis (QCA), Paper presented at the ECPR General on-
ference, 18-21 Sept., Marburg, Germany

Vanderborght, Yannick and Yamasaki, Sakura 2004 Des cas logiques...contradictoires? Un piege
de 'AQQC dejoue a travers ’etude de la faisabilite politique de I’Allocation Universelle, Revue
Internationale de Politique Comparee, Vol.11, pp.51-66
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